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Keeping data highly available.

Protecting against disasters.
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SH/ARE

What is z/OS HyperSwap

Suggested considerations
« HyperSwap specific considerations
« General IOS recovery setting considerations

Other HyperSwap Use Cases
Current Focus and the future
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What is z/OS HyperSwap
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A
z/OS HyperSwap — What it Does SH.xRE
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* Provides HA capabilities — High Availability
« Extension to Sysplex capabilities, and runs within one Sysplex
« Allows swapping to Metro Mirror (Synchronous PPRC) secondary devices
« Swapping is transparent to applications running on the Sysplex

I/Ois redirected to H2

Metro Mirror
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A
z/OS HyperSwap — What it Does SH ARE
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* Provides DR capabilities — Disaster Recovery
« Performs consistent freeze of MM pairs to create time consistency on secondary devices

« Inarolling disaster if a PPRC mirroring suspension occurs followed by a loss of primary devices,
the consistent freeze allows recovery from the MM secondary devices

« Used in HyperSwap configurations, or in
Metro Mirror Configurations using
Hardened Freeze.

* Note the Basic HyperSwap session
type available in no-charge license
of CSM is only HA capable, and
does not support Disaster
Recovery.

Consistent freeze
against all pairs
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z/OS HyperSwap — Interaction with CSM SH ARE
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« IBM Copy Services Manager
controls copy services in storage
environments Session Options | H1-H2 Options

. Can run On Z/OS, On LanX, Metro Mirror Options:
Windows, DS8000 HMC and Metro Mirror Suspend Policy: z/0S Management:

(O Hold /0 after Suspend System or sysplex

Other platforms (® Release 0 after Suspend LOCAL

=
D Enable Hardened Freeze

« z/0S HyperSwap capability is built PR [T

upon the CSM Metro Mirror Cibisable Fyperswa
SeSSion types and itS Variants [JReset In Use By System on Secondary Volumes

[ lunbox Secondary Volumes

View | Modify Properties for session mm

On Planned HyperSwap Error:

(O Partition out the failing systems and continue HyperSwap processing on the remaining system
(@) Disable HyperSwap after attempting backout

On Unplanned HyperSwap Error:

(@) Partition out the failing systems and continue HyperSwap processing on the remaining system
(") Disable HyperSwap after attempting backout

OK Cancel
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HyperSwap Session Types
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Multi-Target MM-GM
w/ Practice Configuration
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What this means to you
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z/OS HyperSwap - Why i1t is needed SH SRE
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Unplanned HyperSwap
* Protects against failures of primary disk storage
* Protects against loss of pathing from host to disk storage
« FICON director failure, severed fibre cables, etc

Planned HyperSwap

« Useful to swap away from controller for change activity:

» Perform a service upgrade of a DS8000

» Significant change to I/O configuration for the primary controller
« This allows the changes to be made non-disruptively

Copyright© by SHARE Association Except where otherwise noted, this work is licensed under a Creative C Attribution-NonC ial-NoDerivs 3.0 license. http: //creativecommons.org/licenses/by-nc-nd/3.0/ @@@@ 10




Value of HyperSwap SH RE

— -
=— CO
—_—
Understand the cost of an outage Need for High Availability
 There could be fines or client satisfaction * Provide for continuous application
Issues if certain applications are processing in the event of an unplanned
Inaccessible for a period of time outage, such as server failure.
Protection against unplanned storage Need to recover from disasters

disruptions can be viewed as an insurance . Ranging from nature, to deliberate attacks,

policy
to human error
* Hopefully you will never have to use it for
non-planned activity
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z/OS HyperSwap - Getting Started SH ARE
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Best Pract_ices for DS8000 and z/0OS HyperSwap with High level, what you need:
Copy Services Manager: « CSM (Copy Services Manager), either on z/0S or

Updated for IBM DS8000 Release 10.1 on an external server such as Windows, Linux, or
https://www.redbooks.ibm.com/redpieces/abstracts oD T o
html o If external, TCP/IP communication is used,
[s8248431.htm P . \
. with AT/TLS encryption
Best Practices for IBM DS8000 and .
gm 2/0S ’alyp:ri\:‘lal}) :;ttn e;nfrr ?351" * Primary and secondary storage controllers at
an . 1
DSB000 Roleacs 10.1 rl\zllier’ﬁgc;)dlstance, and cabled for PPRC (Metro

Awaxcm Kanm

— « Two address spaces running on every system in
the Sysplex (HSIB and HSAPI)

* The z/OS code is part of the I/O Supervisor
component, built into the base control
program of z/0OS
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Suggested Considerations
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CSM and HyperSwap Considerations
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Monitoring a HyperSwap Configuration
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Consider automating on messages to alert team of events that may require
attention:

 Start of a HyperSwap event:
* TOSHM0400I <timestamp> HyperSwap requested

« HyperSwap going disabled, or enabled with limited capability
e *TOSHMO8O03E HyperSwap enabled with limited capability

e *TOSHMOS8O0O3E HyperSwap Disabled
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Messages to look out for SH SRE
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Consider having automation periodically issue a display command to

ensure HyperSwap is enabled

D HS, STATUS

TOSHMO303I HyperSwap Status 002

Number of configurations: 1
Replication Session: MigrationSwapHIH2
Socket Port: 14000

HyperSwap enabled

Swap Highest Priority: No

Disallow Non-MultiTarget System: No
Hardware Reserve Support: Enabled or

New member configuration load failed: Disable HyperSwap Disabled
Planned swap recovery: Disable

Unplanned swap recovery: Partition

FreezeAll: Yes

Stop: No

Verify the text does not show:
HyperSwap enabled with
limited capability
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CSM Alerting SH RE
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CSM can notify users via email notifications or SNMP traps

Consider setting these up to notify your team of potential problems and
unexpected events

Alert Notification

"‘:Fl.-%l v Email

Note: an unplanned
HyperSwap event
would be seen by the S
session transitioning - .

All Events.
States Session State Change
Configuration Change
Unexpected Severe Status
Communication Failure
Active Standby Connected
Active Standby Disconnected

Scheduled Tazk Completed

Scheduled Task Failed

Add Cancel
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Testing HyperSwap

Copyright© by SHARE Association Except where otherwise noted, this work is licensed under a Creative C Attribution-NonC ial-NoDerivs 3.0 license. http: //creativecommons.org/licenses/by-nc-nd/3.0/ @@@@




Testing HyperSwap SH RE

Test Planned HyperSwap:
SETHS SWAP

Test Unplanned HyperSwap:
SETIOS HYPERSWAP

Suggestion: Test while CSM is down to show that z/OS can perform the
HyperSwap actions without communication to CSM
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Testing PPRC Suspension SH RE

* Priortoz/0S 3.1:
 TSO command CGROUP with the FREEZE parameter can be used:
CGROUP DEVN(X'OF40') PRIM(X'6060" 62019) SEC(X'6061' 68006) FREEZE
 Starting with z/0S 3.1

« If using a single target config:
* SETIOS HYPERSWAP, FREEZE

« Ifin a multi-target HyperSwap environment:
* SETIOS HYPERSWAP, FREEZE, CONFIG=MYCONFIGHI1H2

« This command is safer than the CGROUP option: it validates the HS config is loaded and PPRC is in the
correct state before issuing the freeze

Either method will raise an Extended Long Busy condition on the PPRC primary device, as well as
suspend PPRC. This allows z/OS HyperSwap to perform the consistent suspend.

TOSHMO308I PPRC suspension detected for replication session MYCONFIGHI1HZ
FreezeAll and Run completed. Reason: 0000
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SH/ARE

HyperSwap Environment and Operational
Considerations
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HyperSwap Control System SHRE

« HyperSwap actions are Sysplex in scope

* One system is the HyperSwap Controlling System, which facilitates activities among all
other systems.

 In most cases it should not matter

« Some messages are issued only on the controlling system (e.g. HyperSwap requested, etc),
so you can usually infer from operlog which system it is.

« e.g.the following are examples of messages that only are issued on the control system

IOSHMO803E HyperSwap Disabled
TOSHM0400TI 20:38:02.05 HyperSwap requested

Undocumented command F HSIB,D also tells you which system is the Control System
F HSIB,D
IOSHMOPR Control System = SYS1
TOSHM0424I Global Status = 00000000 00000000 0000000A00000000
IOSHMOPR System=SYS1 Status=00000000
IOSHMOPR System=SYSZ2 Status=00000000
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HyperSwap Control System SH RE

« z/QOS prioritizes the HS control system as follows:
« Most capable system

« For example, if system A has no paths to a secondary device but system B is fully
capable for HyperSwap, then system B will automatically be the HS control system

« Highest functional level

 If different members of the Sysplex have different code levels, depending on the
levels, the most up to date one may be prioritized as the HS control system

« Otherwise If all else is equal, the first system with HSIB started wins

« Example: One member of Sysplex is underpowered

« Recommendation: Avoid this type of setup, because an underpowered system could be
a bottleneck in performing HyperSwap steps

 If this configuration is necessary, consider verifying that system is not the HS control
system

 Start HSIB on all other systems before starting it on this system
« Use command F HSIB,D to verify which system is the HS Control system
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Service fixcats SH RE

« We recommend in general to stay up to date on I0S and DFSMS service.
« All HyperSwap related fixes are in IBM.Function.HyperSwap
» 7/0OS fixes related to DS8K: IBM.Device.Disk.DS8000-2107
» Check for service SMP/E by using REPORT MISSINGFIX against that fixcat
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When things go wrong SH RE

Collecting documentation
For z/OS:

* Collect console dumps including IOSAS, HSIB, and HSAPI, preferably on all
systems

DUMP COMM= (Dump title)
R xx, JOBNAME= (IOSAS,HSIB,HSAPI), CONT
R xx, SDATA= (ALLNUC, PSA,CSA,GRSQ, LPA, LSQA, RGN, SQA, SUM, SWA, TRT) , END

* Collect SYSLOG or OPERLOG
» Collect either raw LOGREC buffers, or formatted detailed EREP with type=CHOSXIE
For CSM:

» Gather Diagnostic Package File
» Settings->Advanced Tools->Package Log Files->Create
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Other Diagnosis SH RE

* Debugging: Errors in CSM for Device Not Found

« IWNR5401E No NED was found for the target volume DS8000:2107.FPG11:VOL:8F01. Finding the
target NED failed with return code 920

« Common error codes:
« 901 - LSS not Found
« 905 - UCB not found
« 920 - I0OSCDR error
* 925 - No paths to volume

* Diagnosis:
« For your configuration, identify what the z/OS device number should be. z/OS command
DS QD, SSID=ssss can help with this if it is not known
« Usecommands D M=DEV (dddd) to verify the configuration data IOS has saved matches what is expected
 Usecommand DS P, dddd to verify paths are accessible to the device

* Usecommand DS QD, dddd, SSSCB to verify the SSSCB exists for this device (this is a DFSMS control block
that IOS needs to locate the device)
» Ifnot, try commands DS QD,SSID=ssss,DELETE followed by DS QD,SSID=ssss, VALIDATE
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Technologies to Consider
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zHyperLink
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zHyperLink SHARE

Direct connect short distance IBM Z I/0O feature designed to work in conjunction with a FICON LA TR L et
or High Performance FICON SAN infrastructure.

SENDMSG « FAST enough that the CPU can just wait for the data
(Synchronous) — No un-dispatch of the running task

— No I/O interrupt delay

— No CPU Queueing Delays to resume the I/O

Global Buffer Pool

— No host CPU cache disruption

— Very small I/O Service time

SSCH S zHyperLink

« Operating System and Middleware (e.g. DB2) keep running
(Asynchronous) N <20 usec

over an I/0 rather than giving up control

\ « Transparently gives DB2 and VSAM applications

y, fundamentally better latency than applications on
platforms without zHyperLink (excludes 100% in-memory
databases)

FICON/zHPF

100-130 usec +
Interrupt handling +
CPU dispatch time DS8000

ICON/zHPF
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zHyperLink

Interested in learning more about zHyperLink?

SENDMSG
(Synchronous)

SSCH S zHyperLink
(Asynchronous) N <20 usec

FICON/zHPF

100-130 usec +
Interrupt handling +

ICON/zHPF

CPU dispatch time DS8000
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zBNA (IBM Z Batch Network Analyzer) can be used to
estimate the benefit of zHyperLink and show top data set
candidate lists

« Customers:
https://www.ibm.com/support/pages/node/6354321

« Business Partners:
https://www.ibm.com/partnerworld/techdocs/prs5133

- IBMers:

https://supportcontent.ibm.com/support/pages/node/635
4319

Redbook: Getting Started with IBM zHyperLink for z/OS
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Consistent Read from Secondary
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Consistent Read from Metro Mirror Secondary SHRE

For environments with HyperSwap, with

, CRS: Improve read performance in a metro-
secondary storage kilometers away from the

mirror environment for eligible data sets for the

processor following environments:
Without CRS: « For sin_gle site environment where the primary
. IW'o:\I c CSRS' L he benefit of zH Link DASD is close to the processor and the
Ithout CRS: Lose the benetit of zHyperLink, secondary DASD is significantly distanced from
and asynchronous reads may have to travel the primary, and a swap event occurs

over distance to the primary- « For multiple site environment where there are
* May cause performance objectives and SLAs to one or more processors in both sites, some in

be missed the site with the primary DASD and some in
the site with the secondary DASD
Only processors at the primary site have local
access to DASD and zHL read capability.

With Consistent Read From Secondary, eligible reads can
be satisfied from the local secondary copy of the data
and zHyperLink read will be supported
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Consistent Read from Metro Mirror Secondary

Single Site Workload

FICON
Reads &
zHyperLink . Writes
Reads FICON
FICON -zHyperwrite
Reads & :
Writes

Metro Mirror

DS8000

DS8000

Without Consistent Read
Single Site workload means all systems benefit from
local reads and zHyperLink I/O in normal operation.

but not following a HyperSwap.
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FICON
Reads &
Writes

= zHyperwrite
Eligible FICON :
Reads

Metro Mirror

DS8000

DS8000

With Consistent Read
Even after a hyperswap, zHyperLink and FICON
reads can be performed on the secondary devices.

* Eligible reads — bypass extent checking requested
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Consistent Read from Metro Mirror Secondary A
Multi-Site Workload SH[Z“RE

FICON

FICON

Eligible
zHyperLink zHyperLink zHyperLink FICON
Reads Reads Reads Reads

Metro Mirror Metro Mirror

DS8000 DS8000 DS8000 DS8000
Without Consistent Read With Consistent Read
Multi Site workload results in some systems performing zHyperLink and FICON reads can be performed to
cross-site I0 and not benefiting frqm zHyperLink reads in the local disk (primary or secondary) regardless of
normal operation which DASD is the primary.
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I/O Recovery Settings
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Improved Channel Path Recovery
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Improved Channel Recovery SHRE

« "PATH_SCOPE=CU" recovery
« Improves system resilience for H/W errors

« Itis often better to take a "sick but not dead" path offline sooner rather than later
« IOS recovery delays application I/O even when there are other paths

« In particular:
« IFCC and other path error thresholds
* Proactively removing a path from all devices in an LCU
« IOS can also identify the detecting component in I0OS05xI messages, to help with problem determination

« DASD and tape only
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A
I/O Recovery for Failing Path - Using default settings SH/ARE
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« Example of one bad path affecting a range of devices

Device Path Fails

Application I/0 Application I/0
I/01 I/On
Volume 1 Volume n
ERP Retry ERP Alt. ERP VARY ERP Retry |E,R:1Altt ERP VARY
Path retr ath retry
DL T R ITNN HHHH,

| Client Impact |
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I/O Recovery for Failing Path - Using Improved SHL&RE
Chan nel_ Recovery EDUCATE » NETWORK » INFLUENCE

« Example of one bad path affecting a range of devices - significant improvement with ICR enabled

Device Path Fails

Application I/0 Application 1/0

I/01 I/On

Volume 1 Volume n

Error Events  ERPALt.
Path retry
v Vv lllll i VVYVVY

— Client Impact —
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Improved Channel Recovery SH./\RE
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« IECIOSxx parmlib and SETIOS commands to enable the function:

RECOVERY, PATH SCOPE={DEVICE |CU}
PATH INTERVAL=nn
PATH THRESHOLD=nnn

» Display IOS command to display the status:

D IOS,RECOVERY

I0S103I hh.mm.ss RECOVERY OPTIONS
LIMITED RECOVERY FUNCTION IS DISABLED
PATH RECOVERY SCOPE IS BY CU

PATH RECOVERY INTERVAL IS nn MINUTES
PATH RECOVERY THRESHOLD IS nnn ERRORS
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A
Improved Channel Recovery SHW-\RE
« IFCC Thresholding
« Remove path for intermittent errors

 Remove the path from all devices in the LCU
» ERP path related error monitoring

IOS050I CHANNEL DETECTED ERROR ON dddd,yy,op,stat,
PCHID=pppp

IOS210I PATH RECOVERY INITIATED FOR PATH pp ON CU cccc,
REASON=PATH ERROR THRESHOLD REACHED
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Improved Channel Recovery - Suggestion SHRE

* Typical fabric errors will occur in bursts

* Installations may opt to be more pro-active in terms of how quickly to remove a path from a
control unit.

« If the desired outcome is to be more pro-active, consider using PATH_SCOPE=CU with more
aggressive PATH_INTERVAL & PATH_THRESHOLD values than the default.

RECOVERY, PATH SCOPE=CU, PATH INTERVAL=1,
PATH THRESHOLD=[3-10]

» For this option the path will be removed if there are enough errors in a 1 minute interval to reach
the specified PATH_THRESHOLD

* Note: This RECOVERY function will NOT remove a path from a particular device on the given control
unit if this is the last path to the device, regardless of whether the device is allocated or not.
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* Proactively Removing Paths —
« PATH_SCOPE=CU recovery also takes effect to remove path from entire LCU for:
« DPS Validation Error

IOS051I INTERFACE TIMEOUT DETECTED ON ON dddd,yy,op,stat, PCHID=pppp

e | IOS450E dddd, cc NOT OPERATIONAL PATH TAKEN OFFLINE

IOS210I PATH RECOVERY INITIATED FOR PATH pp ON CU cccc,
REASON=DYNAMIC PATHING ERROR

IOSO001E dddd, INOPERATIVE PATHS pp PP PP

I0S2001T dddd,INOPERATIVE PATHS
STATUS FOR PATH(S) pp,PP,PP-- - -
LOGICAL PATH IS REMOVED OR NOT ESTABLISHED (AO0)
LINK RECOVERY THRESHOLD EXCEEDED FOR LOGICAL PATH (06)

IOS210I PATH RECOVERY INITIATED FOR PATH pp ON CU cccc,
REASON=LINK THRESHOLD EXCEEDED
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« D M=DEV(devno,chp) will display offline reasons

D M=DEV (410, (48))
IEE174I hh.mm.ss DISPLAY M idr
DEVICE 0410 STATUS=ONLINE

CHP 48
ENTRY LINK ADDRESS 22
DEST LINK ADDRESS EO
PATH ONLINE N

CHP PHYSICALLY ONLINE Y

PATH OFFLINE DUE TO THE FOLLOWING REASON (S) ]
[PATH RECOVERY ERROR]
[BY OPERATOR]
[CONTROL UNIT INITIATED RECOVERY]
[CONFIGURATION MANAGER]
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Limited Recovery Time
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Limited Recovery Time SH RE

Problem
» Missing interrupt condition or interface timeout (e.g., I0OS0511I) causes z/0S to validate the channel path
 Validation consists of issuing an I/O to test each path

« Bad paths can encounter elongated recovery times
« I/Otimeoutis 15 seconds + 2 retries are performed = 45 seconds.

« The problem is, application I/O is held to the entire device while validation is performed

Solution

« z/0S parmlib option to limit the amount of time spent doing recovery operations
« IECIOSxx RECOVERY,LIMITED_RECTIME=nn,DEV={DASD|IOTIMING}
« Range 2-14 seconds
» All DASD or only devices with I/O timing enabled

» z/0S uses the specified value to time the recovery I/Os on each path

« Ifrecovery I/O fails with a missing interrupt start pending condition or interface timeout condition, I/O is not
retried on that path
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For scenarios where all paths are affected by a
hardware delay, we want a HyperSwap to trigger
as soon as possible

Maximum I/O impact time =

The sum of:
. . Primary DASD MIH Timeout, AllSNIDs Timeout, HyperSwap
a. The MIH TImeOUt Value Unresponsive SNIDs Start Swap Trigger Completes
b: The time for dynamic pathing validation to
complete

* Without LIMITED_RECTIME:

* b =number of paths x at least
one 15-second timeout with )
multiple retries

* With LIMITED_RECTIME: Max I/O impacttime=a+b+c

* b =number of paths x
LIMITED_RECTIME value

c: user impact time of the HyperSwap
processing after it has been triggered

v
r

F

@O®6
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Consider a low value such as 2
RECOVERY, LIMITED_RECTIME=2 , DEV=DASD

Primary DASD MIH Timeout, All SNIDs Timeout, HyperSwap
Unresponsive SNIDs Start Swap Trigger Completes

A 4

Max I/O impacttime=a+b+c
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Other HyperSwap Use Cases
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« z/OS and CSM can manage a
migration session using HyperSwap

* Provides an easy way to migrate
production data to a new DS8K

« Perform the migration without
needing to stop applications

« This support expands the Migration
session type to use the capabilities
of z/OS HyperSwap
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DS8000 Migrations using z/OS HyperSwap

z/OS
pd
(@]
O
o
Old source
(migrate
from)
GM
Existing
targets

New source
(migrate to)
z/OS HS
allows this
migration with
as little impact
as possible

Global Mirror uses
Global Copy (long
distance) to

Intermediate volumes,

SH./\RE
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Release:
« APAR OA62931
e CSM6.3.7or later

Example configuration:

» Existing session is replicating Global Mirror to existing
targets

* Goalistoreplace old sources with new sources

Similar to a HyperSwap session, z/OS HyperSwap has a
Migration session type between the Migrate-from and

Migrate-to devices
l l Sessions

Session Actions

with periodic consistent _md’ I S e
View/Modify » StanGC H1->H2
Flashes to the target Expot | Suspeed
volumes = Stop
Stop When Drasned
Refresh States
Terminate
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DS8000 Migrations using z/OS HyperSwap

CSM sets up relationship between the current
sources and new sources, starts mirroring in
Global Copy mode

When the user is ready to perform the actual
migration:

« z/0OS HyperSwap performs the steps to
start pairs in Metro Mirror mode

* This helps minimize the time when I/O
writes are being synchronously mirrored,
so we minimize production I/O impact

» z/0OS HyperSwap then waits for all pairs to
convert to Full Duplex, and automatically
performs HyperSwap

After the Migration, z/OS HyperSwap clips
VOLSERSs for old sources to give extra layer of

protection to prevent the user from accessing
downlevel data

Copyright© by SHARE Association Except where otherwise noted, this work is licensed under a Creative C
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This also works in a Multi-Sysplex environment

» z/0S HyperSwap will detect when devices are
shared outside the Sysplex

* CSM performs some coordination, and waits for all
Sysplexes to be ready to migrate before any can

be migrated
---i"'....""-. li".-'....‘.-'lktt
o L. .
,,"" +"s "*
a «* '4. .,
o Sysplex 1 Sysplex 2 5
d *
- e - ™
SN g .
& r Ty & Y s
o ] o - L)
.- ™ '- - ] [}
Old source . - -
I n

(migdrate from .
H1 . < r

BEEE N
antt e,
L ..-

L]
" "
GC % GC e Ge .
g ' :-
. . : -
- b ™ *
*, Mewsource * R o
- . &
midrate to) . . o
’g‘. S * o R
* * *
» 't -
¥ . " -
L -t ., -t
L™ - L] » -
traanan Y L LTI L L]
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HyperSwap Hardware reserve Support
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General recommendation: HS Session for Plex1

« Avoid sharing HyperSwap managed volumes outside
of the Sysplex

 Convert Hardware Reserves to Global ENQs

Systems

Benefit:

« Simplifies the replication management. Each CSM

session corresponds to one Sysplex Shared

volumes

Plex2 l

Systems

« Keeps each HyperSwap session independent. An [
unplanned swap trigger on Plex 1 that is isolated to

that Sysplex would not affect Plex 2

i MM

 IBMrecommendation is to use GRS STAR mode and Plex2.
convert all RESERVEs to ENQs to improve V°‘”mes\i
performance, availability, and serviceability

« See Health Check GRS CONVERT RESERVES HS Session for Plex2

2/11/2026
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Sharing volumes with Systems outside the Sysplex SHARE
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However... HS Session for Plex1

A lot of environments are complicated, and it is easier
said than done to isolate all volumes

If there is a requirement to share volumes:

* This is supported with HyperSwap Hardware
Reserve support enabled

Plex1 ll A

Systems

Shared -~
~~ volumes

How this works:

Plex2 l

« Each Sysplex still has its own HyperSwap session [

Systems
« Hardware Reserves do not have to be converted to
ENQs R MM
N . Plex?.
 Reserve serialization is maintained on the swap-to B
devices when a HyperSwap event occurs h

HS Session for Plex2
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HyperSwap Hardware Reserve Support SH RE

Two main aspects to what HyperSwap Hardware Reserve Support does:
« When a RESERVE is requested for a HyperSwap Primary device, I0OS will synchronously reserve the
primary device
« At any given time, all primary and secondary devices have a consistent view of being reserved or not

« If one Sysplex performs planned or unplanned HyperSwap, all sharing Sysplexes will HyperSwap
* During the HyperSwap of any given Sysplex, I0S will soft fence all swap-from devices

« Assoon as another Sysplex tries accessing one of those devices, it will detect the Soft Fence
condition and will also perform HyperSwap
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Enabling HyperSwap Hardware Reserve Support SH.ARE
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Contact IBM PFE to set a pokeable on
DS8K for enabling HyperSwap Hardware
Reserve P ——

Metro Mirror Suspend Policy: z/0S Management:

Create sessions for each Sysplex S

(® Release 1/O after Suspend \'SVPLEXI v |

[] Enable Hardened Freeze
Enable Hardware Reserves

o ASSOCiate eaCh One With the __ 3 Manage H1-H2 with HyperSwap

[IDisable HyperSwap

CO rres po n d i n g Sys p I.eX [JReset In Use By System on Secondary Volumes

View /| Modify Properties for session TestHRS_PIx1

[[Junbox Secondary Volumes

e Check the “Enable Hardware Reserves”

QO Partition out the failing systems and continue HyperSwap processing on the remaining system

O p‘t i O n i n CS M (@ Disable HyperSwap after attempting backout

On Unplanned HyperSwap Error:
(@ Partition out the failing systems and continue HyperSwap processing on the remaining system
() Disable HyperSwap after attempting backout

OK Cancel
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Current focus:
« Improving performance, expanding use cases and supported environments

Have a request for enhancement?
Please submit to ideas.ibm.com, and vote on ideas that would be valuable to your business.

* These help us prioritize our work, and we love hearing feedback.
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z/OS 3.2 Improved HyperSwap Load Processing SH RE

FLUENC

- At HyperSwap load time, I0S performs I/O Path Validation for all PPRC secondary dewéés
« Inz/0S 3.2, Performance of I/O

Path Validation is improved, which HyperSwap / \
reduces the CPU overhead of Load X 1/0 Path 105 Self

) processing L | Validati I
HyperSwap load processing, [ verdaten Description
Offline Device Discovery, and other
callers.
10S
) ' . Dynqmic
« Ina configuration with 8 paths per Offline Pathing
. B . . Device
device, this will avoid: Discovery
« 42 getmains per device Device

. 14 1/Os per device K e /

« z/0S 3.1 and below: Each of these sections of code would perform individual
getmains/freemains for their dynamic areas
« With thousands or tens of thousands of devices, this is a lot of repetitive
getmains
» Inz/0S 3.2, I0S will obtain one storage pool per LSS, and reuse it for each of the
sections of code
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CSM Documentation and Pages
Documentation home for IBM Copy Services Manager
https://www.ibm.com/docs/en/csm

CSM Supported Products and Platforms Interoperability Matrix Links
https://www.ibm.com/support/pages/find-copy-services-manager-supported-storage-
system-and-platform-matrix-links

CSM YouTube channel
https://www.youtube.com/channel/UC2KaP7qpv4Z9yJ75Yiol-pA
Books related to z/OS HyperSwap
Best Practices for IBM DS8000 and IBM z/0S HyperSwap with IBM Copy Services Manager
New draft available, updated December 2025
https://www.redbooks.ibm.com/redpieces/abstracts/sg248431.html

IBM Copy Services Manager Implementation Guide
http://www.redbooks.ibm.com/abstracts/sg248375.html?0Open
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Questions?

Please also reach out through email or LinkedIn at any time with z/OS HyperSwap questions, comments, and
suggestions

Tabor Powelson - tpowels@us.ibm.com

Tarig Hanif - thanif@us.ibm.com
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Your feedback is important! SHARE

Submit a session evaluation for each session you attend:

www.share.org/evaluation

A

A

www.share.org/evaluation
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« The technical content of this presentation is copyright of IBM
« See URL: hitps://www.ilbm.com/legal/copyirade for a list of trademarks.

Copyright© by SHARE Association Except where otherwise noted, this work is licensed under a Creative C Attribution-NonC ial-NoDerivs 3.0 license. http: //creativecommons.org/licenses/by-nc-nd/3.0/ @@ @ @ 67



https://www.ibm.com/legal/copytrade

	Unlocking the Power of HyperSwap
	Slide 1: Unlocking the power of z/OS HyperSwap for High Availability of Storage
	Slide 2: Keeping data highly available.  Protecting against disasters.

	Agenda
	Slide 3: Agenda

	What is z/OS HyperSwap
	Slide 4: What is z/OS HyperSwap
	Slide 5: z/OS HyperSwap – What it Does
	Slide 6: z/OS HyperSwap – What it Does
	Slide 7: z/OS HyperSwap – Interaction with CSM
	Slide 8: HyperSwap Session Types
	Slide 9: What this means to you
	Slide 10: z/OS HyperSwap - Why it is needed
	Slide 11: Value of HyperSwap
	Slide 12: z/OS HyperSwap - Getting Started

	Suggested Considerations
	Slide 13: Suggested Considerations
	Slide 14: CSM and HyperSwap Considerations
	Slide 15: Monitoring a HyperSwap Configuration
	Slide 16
	Slide 17
	Slide 18
	Slide 19: Testing HyperSwap
	Slide 20
	Slide 21
	Slide 22: HyperSwap Environment and Operational Considerations
	Slide 23
	Slide 24
	Slide 25
	Slide 26
	Slide 27
	Slide 28: Technologies to Consider
	Slide 29: zHyperLink
	Slide 30: zHyperLink
	Slide 31: zHyperLink
	Slide 32: Consistent Read from Secondary
	Slide 33: Consistent Read from Metro Mirror Secondary
	Slide 34: Consistent Read from Metro Mirror Secondary Single Site Workload
	Slide 35: Consistent Read from Metro Mirror Secondary  Multi-Site Workload
	Slide 36: I/O Recovery Settings
	Slide 37: Improved Channel Path Recovery
	Slide 38
	Slide 39
	Slide 40
	Slide 41
	Slide 42
	Slide 43
	Slide 44
	Slide 45: Improved Channel Recovery
	Slide 46: Limited Recovery Time
	Slide 47: Limited Recovery Time
	Slide 48: Limited Recovery Time
	Slide 49: Limited Recovery Time

	Other HyperSwap Use Cases
	Slide 50: Other HyperSwap Use Cases
	Slide 51: DS8000 Migration Using z/OS HyperSwap
	Slide 52: DS8000 Migrations using z/OS HyperSwap
	Slide 53: DS8000 Migrations using z/OS HyperSwap
	Slide 54: DS8000 Migrations using z/OS HyperSwap
	Slide 55: HyperSwap Hardware reserve Support
	Slide 56: Sharing volumes with Systems outside the Sysplex
	Slide 57: Sharing volumes with Systems outside the Sysplex
	Slide 58: HyperSwap Hardware Reserve Support
	Slide 59: Enabling HyperSwap Hardware Reserve Support

	The Future
	Slide 60: Current Focus and The Future
	Slide 61: z/OS HyperSwap
	Slide 62: z/OS 3.2 Improved HyperSwap Load Processing
	Slide 63: Links and further information
	Slide 64: Experience more with IBM
	Slide 65: Thank you
	Slide 66
	Slide 67: Trademarks and Copyright


